ACCESS TO THE INTERNET

For optimum performance in AdvantageEDC, use Safari 3.1 (or higher). Previously,
AdvantageEDC was only supported on Microsoft Internet Explorer versions 5.5 and higher. We
now support Firefox 2.0+ and Safari 3.1+ browsers and Chrome. Although the system may be
accessed using earlier versions of Internet Explorer, they are not supported and some fields and
functions may not appear or work properly using these alternate browsers. If you are unsure
about the browser version you are using, click the Help menu of your browser and select About
Internet Explorer/Mozilla Firefox/Safari. A screen will display your browser version
information. If no browser is installed on your machine, you should arrange to have an
appropriate browser installed, and then proceed.

Please follow the links below based on the browser that you use.

Internet Explorer users

Firefox users

Safari users

iPhone/ iPad users

For Chrome Users




1.0 For Internet Explorer 7 Users:

With the enhanced security features of Internet Explorer 7, the following additional steps must
be taken to configure your browser before accessing AdvantageEDC:

1. Open Internet Explorer 7.
2. Click on the Tools menu item.

Access the Internet Options.

oW

Click on the Privacy tab.

5. Under the Settings section, set the vertical slider bar to Medium as shown below:

Internet Options H

izeneral | Security | Privacy | Content | Conmections | Programs | Adwvanced

Settings

‘;_ Select a setting For the Internet zone.

- Blocks third-party cookies that do not have a compact
privacy policy

- Blacks third-party cookies that save information that can
= be used ko conktack wou without vour explicit consenk

- Restricts First-party cookies that save information that
ran be used to contack you wikhouk your implicit consent

[ Sites ] [ Import ] [ Advanced

Pop-up Blocker

| j|  Prevent most pop-up windows From
- appearing.

[ ] Turn on Pop-up Elocker

Ik l [ Cancel




6. Under the Pop-up Blocker section, click the check box that says Turn on Pop-up
Blocker as shown below:

Internet Gptions -\

izeneral | Security | Privacy | Content | Conmections | Programs | Advanced

-

Settings

:_ Select a setting For the Internet zone,

@I

Medium

- Blocks third-party cookies that do nok have a compact

privacy palicy

- Blocks third-party cookies that save information that can
L be used to conkack wou without yaur explicit consent

- Restricts first-party cookies that save information that

can be used ko conkact wau withaut waour implicit consent

[ Sites ] [ Impork ] [ Advanced ]

Pop-up Blocker

I§ ! Presvent most pop-up windows From Settings

appearing.

[«]Turn on Pop-up Blocker!

(0] 4 H Cancel H apply




7. Click on the button next to the checkbox named Settings. Add
https://secure.emmes.com, https://pub.emmes.com/, and https://web.emmes.com
to the exceptions list for the pop-up blocker (see figure below) by typing in the URLs
and clicking on Add. The URLs will get listed in the textbox entitled Allowed sites.

Pop-up Blocker Settings m

Exceptions

— Pop-ups are curently blocked. You can allow pop-ups from specific
l f_’l websites by adding the site ta the list below.
¥

Address of website to allow:

Allowed sites:

pub.emmes.com
SEecure.emmes.com
web.emmes.com Remove all..

i

Notifications and filter level
[V Play a sound when a pop-up is blocked.
[V Show Information Bar when a pop-up is blocked.

Filter level:
IMedium: Block most automatic pop-ups _vJ
Pop-up Blocker FAQ Close I

8. Click on Close. This will return you to the Internet Options window.

9. Under the Security tab, select the zone that shows a globe labeled Internet.


https://secure.emmes.com/
https://pub.emmes.com/
https://web.emmes.com/

10. Under the section titled Security level for this zone, set the vertical slider bar to
Medium-high as shown below:

Internet Options ﬁ

Generall Security |Pri~.-'au:';.-' Content | Connections | Programs | Advanced

—

Select a zone ko view ar change security sethings,

@ Q@ v O

Internet Local intranet  Trusted sites  Restricted

sites
Internet
@ This zone is for Internet websites,
except those listed in trusted and
restricked zones,
Security level For this zone
Allowed levels For this zone: Medium to High
: | Medium-high
i - Appropriate Far most websites
i - Prompks before downloading pokentially unsafe
cankent

- Unsigned ActiveX contrals will nat be downloaded

Custom level...

[ Reset all zones to default level ]

[ Ok l [ Cancel




11. Click on the button Custom level (as shown below).

Internet Cptions

izeneral | S0ty | Privacy | Content | Conneckions | Programs | Advanced

Select a zane ko view ar change security sethings.,

@ 9 /e

EInternet} Local intranet  Trusted sites Restricted

sites
Internet
@ This zone is For Inkernet websites,
excepk those listed in trusted and
restricted zones,
Security level for this zone
Allowed levels for this zone: Medium ko High
Medium-high
- - Appropriake for mosk websites
- Prompts before downloading potentially unsafe
cankent

- Unsigned Activer controls will not be downloaded

Cuskom level, .,

[ Reset all zones ko defaulk level ]

[ Ok H Cancel ]

12. This opens up another window (see below). Scroll down to Scripting. Click Enable
for the option titled Allow status bar updates via script. Click OK to return to the
Security tab.



[ 1

Security Settings - Internet Zone
Sekkings
) Disable [A]
%) Enable
{:} Prompk

=| Scripting

=] Active scripking
) Disable
%) Enable
) Prompk

= | Allovs Programmatic clipboard access
) Disable
) Enable
) Prompk

= | Allovs stabus bar updates via script [

<] S | 12

*Takes effect after vaou restart Internet Explarer

Reset custom setkings

Reset t0: [ mecium-high (default) v| [ Resst.. |

[ (8] 4 ] [ Cancel ]

13. Select the zone Restricted Sites. Click on the button Custom level as seen below.



Internet Options

izeneral | SeCurity | Privacy | Content | Conmections | Programs | Advanced

Select a zone bo wiew or change security setkings.

¢ <« J

Internet Local intranet  Trusted sites

Restricted sites

This zone is for websites that might
damaqge yaur computer ar your files,

Security level For this zone
Allowed levels For this zone: High
High
- Appropriake for websites that might have harmful
cankent

- Maximurm safequards
- Less secure features are disabled

Cuskam level, ..

[ Reset all zanes to defaulk level ]

[ (0] 4 H Cancel ]

14. This opens up another window as seen below. Scroll down to Scripting. Click Enable
for the option titled Allow status bar updates via script. Click OK to return to the
Security tab.



[ 1

Security Settings - Internet Zone
Sekkings
) Disable [A]
%) Enable
{:} Prompk

=| Scripting

=] Active scripking
) Disable
%) Enable
) Prompk

= | Allovs Programmatic clipboard access
) Disable
) Enable
) Prompk

= | Allovs stabus bar updates via script [

<] S | 12

*Takes effect after vaou restart Internet Explarer

Reset custom setkings

Reset t0: [ mecium-high (default) v| [ Resst.. |

[ (8] 4 ] [ Cancel ]

15. Select the Trusted sites zone indicated by the green check mark (shown below):



-,

rlnternet Options

General | Security |F‘rivacy Content | Connections || Programs || Advanced

Select a zone to view or change security settings.

@ € v O

Internet Local intrangt  Trusted sites  Restricked
sites

Trusted sites

: f This zone contains websites that you
W trust not to damage vour computer or
vour files,
You have websites in this zone.,

Security level For this zone

Custom
_ustom setkings.
- To change the settings, click Custam level,
- To use the recommended settings, click Defaulk level,

[ Custam level. .. ][ Default level ]

’ Reset all zones to default level ]

[ ] H Cancel ]

16. Click the Sites button. A new window will open up (shown below).

Trusted sites

A7 You can add and remove websites Fram this zone, All websites in
il this zone will use the zone's security setkings,

add this website ko the zone:

Websites:

ihttps: jisecure.emmes, com Remave

[ Jrequire server vetification (https:) For all sites in this 2one

Close




17. Add https://secure.emmes.com, https://pub.emmes.com/, and
https://web.emmes.com to your trusted sites by typing in the URLs and clicking
Add. The URLs will get listed in the text box entitled Websites.

18. Once this is done, click Close. This will return you to the Security tab.

19. Under the section titled Security level for this zone, click on the button named
Custom Level to open a window shown below.

Security Settings - Trusted Sites fone

Sekkings

3‘3 Downloads A
3‘3 Automatic prompking For file downloads

22 File dowrload
() Disable
(%) Enable
3‘3 Faont download
() Disable
(%) Enable
) Prompt
3‘3 Enable .MET Framework setup
() Disable
(%) Enable
=) Jawa WM
=8 Mzws marmiccinne i
*Takes effect after vou restart Internet Explorer

Reset custom setbings

Resstbor | Medium (default) V

[ OF, ] [ Cancel l

20. Under Downloads, for the subtitle Automatic prompting for file downloads change

the setting to Enable. When finished, click OK to return to the Internet Options
window.


https://secure.emmes.com/
https://pub.emmes.com/
https://web.emmes.com/

21. Click on the General tab. Under the Temporary Internet Files section, click on the
button named Settings (as shown below). If the option Every visit to the page is
selected, you are ready to begin using Internet Data Entry System. If it is not already
checked, click on the circle. Click OK on the Settings window. Click OK on the
General tab to close the window.

Internet Oplions -

General I Securit}ll Eontentl Eonneclionsl F'n:ugramsl .-’-'-.dvanu:edl

T |

‘ Check far newer verzsions of stored pages:
&

" Ewery time vou start Internet Explorer
 Automatically
O Mewver

— Temparany Internet files folder

Current location: D WWwWIMM T WProfileshntimagehT ermporary [nternet
Filesh

Amount of disk space o uze:

j | Z50=] ME

Move Folder. .. Wiew Files... I Wiew Objects... I

Ok I Cancz| I

Ok I Cancel | gy I

22. If you get any of the following messages when trying to log in:

a. You are using an internet browser that does not support JavaScript 1.1 and
above. Please upgrade your Internet browser and try again.

i. Follow steps 1,2,3,9 and 10 under section 1.0

b. You have a popup blocker enabled. Please allow popups from emmes.com
and try again.

i. Followstep 1,2, 3,4, 6,7 and 8 under section 1.0

c. Depending on your Internet browser, you may need to modify the Internet
Options for Privacy to a setting that does not block cookies. Please modify
the settings and try again. Note that we do not store any of your personal
information in the cookie.

i. Follow step 1,2, 3,4 and 5 under section 1.0



You are using an Internet browser not supported by AdvantageEDC. Please
upgrade your internet browser and try again.

i. Have Internet Explorer 6.0+ or Firefox 2.0+ or Safari 3.1+ installed
on the machine.

You are using an Internet browser version not supported by AdvantageEDC.
Please upgrade your internet browser and try again.

i. Have Internet Explorer 6.0+ or Firefox 2.0+ or Safari 3.1+ installed
on the machine.



1.1 For Fire Fox 2.0+ Users:
The following steps must be taken to configure Firefox before accessing AdvantageEDC:

Open Firefox 2.0+

Click on Tools menu item.

Access Options.

Click on the Content tab.

Check the checkbox Enable Javascript (shown below).

rl:l ptions

o & & o

Main Tabs Conkent  Applicakions  Privacy  Security  Advanced

uhwnNRE

[ ] Block pop-up windows

Load images automatically Exceptions. ..

Advanced...

Enable Java

Fonts & Caolars
Defaulk Fonk: | Times Mew Rorman v Sizer |16 v Advanced...

Colors. .

Languages

Choaose wour preferred language For displaving pages Choose...

Ik l [ Zancel ] [ Help




6. Check the checkbox Block pop-up Windows as shown below. Click on the button
Exceptions to the right of the checkbox.

| Options I

UB8=E b F 8 O

Main Tabs Content  Applications  Privacy  Secority  Adwanced

[+]: Block pop-up windows: Exceptions...

Load images automatically Exceptions...
Enable Javascript Advanced...

Enable Java

Fanks & Calars
Default Fonk; | Times Mew Roman v Size: |16 v advanced...

Colors...

Languages

Choose wour preferred language For displaying pages Choose...




7. This will open up a new window (see below). Add https://secure.emmes.com,
https://pub.emmes.com/, and https://web.emmes.com to the exceptions list for the
pop-up blocker by typing in the URLs and clicking on Enable. The URLs will get listed in
the textbox below with a status of enabled. When finished, click Close to return to the
Options window.

= -

& Allowed Sites - Pop-ups g@

You can specify which web sites are allowed to open pop-up windows, Tyvpe
the exact address of the site wou want to allow and then dlick Allow.

Address of web site:

Site Skatus
SECUFE, BMMEs, Com Enabled

Remove Site ] [Rgmu:we all Sites



https://secure.emmes.com/
https://pub.emmes.com/
https://web.emmes.com/

8. Click on the button named Advanced below the button named Exceptions. This will

open a new window (shown below). Select the checkbox Change status bar text. Click
on OK.

e .l

Advanced JavaScript Settings

Allawe scripks bo:

|:| Move or resize existing windows
[ ] raise ar lower windaws

[ ] Disable or replace context menus
[ ] Hide the status bar

[+]: Charge skatus bar ket

[ Ok ] [ Cancel ] [ Help

9. Click on the Privacy tab. Check the checkbox under Cookies subsection titled Accept
cookies from sites (see below). Click on OK:

s =1

Options

0w & 8 &

Main Tabs Conkent  Applicakions  Privacy  Security  Advanced
History
[] keep my history For at least days

[] Remember what I enter in forms and the search bar

[ ] remember what I've downloaded

Cookies

[«]: Accept cookies From sites i | Exceptions...

Accept third-party cookies

Keep until: | ask me every time v Show Cookies. ..

Private Data

[] Ahways clear my private data when I close Firefiox Sektings...

[ ] &sk me before clearing private data Clear Mow. ..

K l [ Zancel ] [ Help ]

10. If you get any of the following messages when trying to log in:



You are using an internet browser that does not support JavaScript 1.1 and
above. Please upgrade your Internet browser and try again.

e Follow steps 1 through 5 under section 1.1

You have a popup blocker enabled. Please allow popups from emmes.com and
try again.

e Followstep 1,2, 3,4, 6 and 7 under section 1.1

Depending on your Internet browser, you may need to modify the Internet
Options for Privacy to a setting that does not block cookies. Please modify the
settings and try again. Note that we do not store any of your personal
information in the cookie.

e Follow step 1,2, 3 and 9 under section 1.1

You are using an Internet browser not supported by AdvantageEDC. Please
upgrade your internet browser and try again.

e Have Internet Explorer 6.0+ or Firefox 2.0+ or Safari 3.1+ installed on
the machine.

You are using an Internet browser version not supported by AdvantageEDC.
Please upgrade your internet browser and try again.

e Have Internet Explorer 6.0+ or Firefox 2.0+ or Safari 3.1+ installed on
the machine.



1.2 For Safari 3.1+ Users:

The following steps must be taken to configure Safari before accessing AdvantageEDC:

Open Safari.

Click on the Edit menu item.

Select Preferences.

Click on the Security tab.

Under the Web content section, check the checkbox titled Enable Javascript.‘

Security (]

uhwnNRE

Fraudulent sites: W Warn when visiting a fraudulent website

The Google Safe Browsing Service is unavailable.
L MNo updates have occurred in 4 days.

Web content: E Enable plug-ins
E Enable Java
E Enable JavaScript
[ Block pop-up windows

Accept cookies: O Always
() Never
8 Only from sites you navigate to
For example, not from advertisers on those sites.

( Show Cookies )

Default database maximum size: |' 5 MB l-ﬂ

( Show Databases )

] Ask before sending a non-secure form to a secure website

@

6. Uncheck the checkbox titled Block pop-up windows. This is the checkbox right below

the checkbox for 5 as shown above.

7. Under the section Accept cookies, select the radio button titled Only from sites you
navigate to as shown above. Click on the X on the top right corner of the window to

close the window.

8. Another way to enable pop-ups is to click on the Edit menu and to ensure that the Block

pop-up windows option does not have a check mark next to it as shown below:



[ 4| Undo Cirl+Z

Redo Ctrl+5hift+Z
Cut Ctrl+X
Copy Ctrl+C
Paste Ctrl+WV
Delete el
Select All Ctri+A
AutoFill Form Cirl+5hift+A
Fing k
Spelling and Grammar ¥
Private Browsing...

Reset Safari. ..

Empty Cache... Ctrl+Alt+E
Block Pop-Up Windows Crrl+5hift+K
Preferences... Ctrl+,

9. To enable viewing of the status bar, click on View menu item and select Show Status
Bar as shown below.

Show Bookmarks Bar Ctrl+5hift+B

Show Status Bar Ctrl+/

Show Tab Bar Ctrl+5hift+T
Hide Toolbar Ctrl+5hift+Y
Customize Toolbar...

Stop Ctrl+.
Reload Page Ctrl+R
Make Text Bigger Ctrl++
Make Text Normal Size Ctrl+0
Make Text Smaller Ctrl+-
Wiew Source Crrl+Alt+U
Text Encoding L

9. If you get the following message when trying to log in:

a. You are using an internet browser that does not support JavaScript 1.1 and
above. Please upgrade your Internet browser and try again.



e Follow steps 1 through 5 under section 1.2

You have a popup blocker enabled. Please allow popups from emmes.com and
try again.

e Follow step 1,2, 3, 4 and 6 or step 8 under section 1.2

Depending on your Internet browser, you may need to modify the Internet
Options for Privacy to a setting that does not block cookies. Please modify the
settings and try again. Note that we do not store any of your personal
information in the cookie.

e Follow step 1,2, 3,4 and 7 under section 1.2

You are using an Internet browser not supported by AdvantageEDC. Please
upgrade your internet browser and try again.

e Have Internet Explorer 6.0+ or Firefox 2.0+ or Safari 3.1+ installed on
the machine.

You are using an Internet browser version not supported by AdvantageEDC.
Please upgrade your internet browser and try again.

e Have Internet Explorer 6.0+ or Firefox 2.0+ or Safari 3.1+ installed on
the machine.



1.3 For iPhone/ iPad Users:

The following steps must be taken to configure Safari browser on iPhone/ iPad before accessing
AdvantageEDC:

1. Click on the Settings icon.

2. Within Settings, click on the Safari menu as shown below.

s ATET B 10:24 PM )

@ Brightness >

g Wallpaper >

@ General >

I ! Mail, Contacts, Calendars >

u Phone >
Q@ s > >

'i‘ iPod >
L*j Photos >

3. Verify that Javascript is ON and Block Pop-ups is OFF as shown below.



JavaScript

Plug-ins

Block Pop-ups

Accept Cookies From visited >

Clear History

Clear Cookies



1.4 For Google Chrome Users

The following steps must be taken to configure Safari browser on iPhone/ iPad before accessing
AdvantageEDC:

1. Click the 3 horizontal lines icon on the far right of the Address bar.

— 4

2. Click on Settings,

-

Mew tab

Mew window
Mew incognito window
Bookmarks k

Recent Tabs r

Edit Cut  Copy Paste

arat=ry

Zoom - 100%  +

Save page as..
Find...
Print...

Tools r

History

Downloads

Signed in as

About Google Chrome

Help 3

Exit




On the setting page, scroll to the bottom and click the Show Advanced Settings link.

Show home button

Hisable »
Show bookmarks bar ®
Forit size Medium (Recommended) -
Cusiomize fants ¥
Fage Zo0m 100% -
Search engine
Search engine used in the address bar Googhe -
banage search engines v

Defaull browser

: MAKE DEFALLT
& the default browser

On startup

Computer Services Help Desk - Missouri Slate University

httpshelpdesk missouristate edwlandingpaga/opanlabs

3. Click on Change proxy settings.

System
Continue running background apps when Google Chrome is closed B »

Use hardware acceleration when available ®

Open proxy settings




4. Click the Security tab

General Privacy | Content | Connections | Programs I Advanced
To set up an Internet connection, dick
Setup,

Dial-up and Virtual Private Netwaork settings

Add...

Remaove...
Choose Settings if you need to configure a proxy Settings
server for a connection,
(@) Never dial a connection
| Dial whenever a network connection is not present
) Always dial my default connection
Current Mone Set default

Local Area Metwork {LAN) settings

LAN Settings do not apply to dial-up connections.

Choose Settings above for dial-up settings.

| CK | | Cancel Apply

5. Click Trusted Sites icon

| General | Security | privacy | Content | Connections | Programs | Advanced |

Select a zone to view or change i inas.

@ & /|0

Local intranet i Trusted sites|  Restricted

sites
Internet . =
Q This zone is for Internet websites, bz
except those listed in trusted and
restricted zones.
Security level for this zone
Allowed levels for this zone: Medium to High
Medium-high
- Appropriate for most websites
- Prompts before downloading potentially unsafe
content

- Unsigned ActiveX controls will not be downloaded

Enable Protected Mode (requires restarting Internet Explorer)
Custom level... ‘ Default level |

| Resetal zones to defauitievel |

(o J[ cancad J[ a0y




6. Click Sites.

| General | Security |Pn'vaqr I Content I Connections | Programs I Advanced

Select a zone to view or change security settings.

@ & v 0O

Internet Localintranet QTS Restricted
sites

Trusted sites

This zone contains websites that you
trust not to damage your computer or
your files,

You have websites in this zone,

Security level for this zone
Allowed levels for this zone: All

Medium
- Prompts before downloading potentially unsafe
- content
- Unsigned ActiveX controls will not be downloaded

[T Enable Protected Mode (requires restarting Internet Explorer)
Custom level... Default level

Reset all zones to default level

ﬂ Some settings are managed by your system administrator.

| (0]4 || Cancel | Apply

7. Enter the URL of each of the Emmes sites to the Trusted Sites and click Add after each,
https://secure.emmes.com, https://pub.emmes.com/, and https://web.emmes.com.

O Trusted st — . S

You can add and remove websites from this zone. All websites in
this zone will use the zone's security settings.

Add this website to the zone:
I Add

Websites:

https: /{*.emmes.com Remove

https://pub.emmes.com
https:/jweb.emmes.com

Require server verification (https:) for all sites in this zone

8. Click Close > OK.


https://secure.emmes.com/
https://pub.emmes.com/
https://web.emmes.com/

